CONTENTS

4
Using a GPS Track
Log in Lightroom

14
Using Teleconverters

23
Step by Step:
Neon Text

32
Diffusion for Healing

38
Time-Lapse Tips

ON THE COVER
Snow-covered trees in southern Austria. Captured at a focal length of 105mm with an aperture of f/8 and a shutter speed of 1/750th of a second at ISO 400.
The subjects for the articles in this month’s issue of *Pixology* magazine were selected based on direct feedback from photographers, in many cases while talking about photography in between photo shoots.

Of course, while getting feedback and answering questions from photographers, I’m often reminded of issues that I don't necessarily think about all that often. For example, I don’t tend to employ teleconverters all that often, and yet when the situation warrants it this small and simple accessory can be tremendously helpful.

I hope you find the articles in this issue—inspired by conversations with other photographers—to be helpful in your own photography. And, of course, I’m always interested in hearing from you about the topics you’d like to see covered in future issues of *Pixology* magazine.

Tim Grey
Editor
Adding Location Details to Photos by Recording a GPS Track Log

In many cases it can be helpful—or simply interesting—to be able to identify the specific location where you captured a given photo. While an increasing number of new camera models include a built-in GPS receiver, it is also possible to add location information to photos by recording a track log during a photography outing, and then synchronizing that track log to your photos.
Recording a Log

The first step to making use of a GPS track log is to actually create that track log in the first place. In concept this is as simple as starting the process of recording a track log when you first begin exploring an area with your camera in hand, and to stop recording the log when you’re finished with your exploration.

Of course, there are various details you’ll want to consider when it comes to creating a track log. First, you’ll need to determine how you’ll create the actual track log in the first place.

Put simply, a GPS track log is a list of times and GPS coordinates. While you are recording a track log, your current position will be recorded at set intervals. The time information from the track log can then be synchronized with the time of capture for each photo, so that the location information can be matched up with your photos.

A wide variety of GPS-capable devices are able to record a track log. In fact, some cameras that have a built-in GPS receiver include the option to record a track log in addition to being able to embed location information into the metadata for your photos as you capture them.

The first consideration when it comes to choosing which device to use to record a track log is what device you might already be bringing with you. For example, many GPS navigation units include a feature for recording track logs. If you’re using such a GPS device to navigate on a road trip or to find your way hiking in the backcountry, for example, you may be able to use that device to record a track log.

Many photographers, of course, also carry a smartphone with them during their travels. There
are a wide variety of apps available for these devices, which enable you to record track logs. My personal app of choice is GPSTrack. This app by John Bafford is available for the iPhone, and information can be found at http://bafford.com/gpstrack. There are, of course, many other apps available for a wide variety of devices.

Note that Lightroom supports track logs in the GPX (GPS Exchange Format) file format. This is a format that is commonly supported by many GPS-enabled devices. It is a good idea, however, to confirm that the device or app you plan to use supports recording GPS track logs in the GPX format, and that if there is more than one file format option available that the GPX option is selected.

Before you begin recording a track log, it is highly recommended that you check the time on both your camera and the device you’re using to record the track log. Keeping in mind that location information is synchronized to your photos based on capture time, you can appreciate that the two devices should have their time set accurately. For the most accurate results you also want to be sure the clocks on both devices are synchronized to each other with as much precision as possible.

It is also important to consider the limitations of GPS signals. For example, when you are indoors you will generally not have adequate signal strength from enough GPS satellites to obtain accurate location information. In addition, when you don’t have a clear view to the sky—such as when you are among tall buildings in a large city—you may find that the location information is not accurate.

While GPS technology can be imperfect for determining your precise location at any given
moment, in general I find it is helpful to have at least some sense of your location rather than no information at all.

To help improve the overall accuracy of your track log, I recommend that you start recording when you are outdoors with an unobstructed view of the sky. With most devices or apps that enable you to record a GPS track log you are able to see an indication of signal quality or location accuracy. Waiting until you have a high degree of location accuracy before you start recording your track log can improve the overall quality of the location information in your track log.

You can then use the record function of the tool you’re using to start the process of recording a track log. When you’re finished with your photographic exploration—or your exploration in general—you can stop recording the track log.

**Downloading the Log**

Once you’ve recorded a track log during a photo outing, you’ll need to download that track log to your computer so it can be made available for synchronization within Lightroom. The specific mechanism for downloading the track log will vary based on how you actually recorded the log file.

If, for example, you are using an app on a smartphone to record your track log, you can very likely email the log to yourself so you can save the email attachment on your computer. You may also be able to use other file transfer options, such as a wireless connection. In some cases you may need to connect the device you used to record the track log to your computer, and then download via that connection.
Once you’ve actually saved the track log to your computer, I recommend moving the log file to the same folder as the photos that the track log relates to. In other words, my general approach would be to first download the photos from my photo outing, and then download my GPS track log and save it to the same folder location as the photos. After all, the track log itself relates to the photos in that folder, so the log may as well be saved in the same location.

After you’ve downloaded your track log to your computer and saved it in an appropriate location, you can use that track log as the basis of adding location information to the photos that were captured while you were recording the track log.

**Syncing Photos**

As you might expect, location information for your photos can be viewed, updated, or added via the Map module in Lightroom. So, when you’re ready
to add location information to your photos based on a track log, you’ll first want to navigate to the folder that contains the applicable images within the Library module in Lightroom, and then switch to the Map module.

Below the map display in the Map module you will find a toolbar. If that toolbar isn’t visible you can press the letter “T” on the keyboard to display the toolbar. Then click the Track Log button (it has a “zigzag” icon) on the toolbar and choose “Load Tracklog” from the popup menu.

In the dialog that appears you can navigate to the folder that contains the track log that applies to the photos you’re currently working with. Then select the specific track log file and click the Choose button. At this point the track log will

Once you have saved a track log in the same folder as the photos the log relates to, you can load that track log within the Map module in Lightroom to see the track plotted on the map.
be loaded into Lightroom, with the route you covered while recording the track log displayed within the map area.

If for any reason the time zone for your track log does not match the time zone for your photos, you can apply an adjustment to the track log you have loaded. To do so you can use the Set Time Zone Offset command found on the popup menu for the Track Log button on the toolbar below the map display in the Map module.

When you choose the “Set Time Zone Offset” command, the Offset Time Zone dialog will appear. This allows you to simply shift the time zone for the data in the GPS track log, to correct for a mismatch in time zone for the track log. Keep in mind that this adjustment can be avoided altogether by making sure that your camera and GPS-enabled device are set to the same time (and time zone if applicable) prior to initiating the recording of your track log.

Of course, if the photos themselves have inaccurate capture times you will instead (or also) want to use the Edit Capture Time command found on the Metadata menu in the Library module to adjust the capture time for the images.

To synchronize photos in order to add location information, you can select the specific range of images that you want to assign GPS location from within Lightroom.

If the local time was not set properly on your GPS device, you can apply an offset to the track log from within Lightroom.
After loading a track log into Lightroom, you can select the applicable photos and choose the “Auto-Tag” option to add location information to the selected photos based on the track log.

Information to based on the track log you’ve recorded. However, in most cases it is easier to simply select all photos from the folder you’re currently browsing.

If you prefer to select a specific range of photos, you can click on the first image in the sequence on the filmstrip, and then hold the Shift key and click on the last image in the sequence. If you want to select all photos you can choose Edit > Select All from the menu, or press Ctrl+A on the keyboard on Windows or Command+A on Macintosh.

With the track log loaded and the applicable photos selected, you can add location information to the selected photos based on the track log by choosing the “Auto-Tag Selected Photos” command from the track log popup on the toolbar below the map. Note that this command will also reflect the number of photos that are currently selected, so you have a sense of how many images you are processing.

Once you have chosen the “Auto-Tag Selected Photos” command, Lightroom will add location information to the selected photos based on the loaded GPS track log. Any selected photos that fall outside the time frame that the track log was recorded will not have any location added. Photos that were captured during the time frame that the track log was recorded will have location
Once you have synchronized your photos to a track log, placeholders for those photos will appear on the map and GPS coordinates will be included in the metadata for the photos.

In other words, for photos captured while you were recording the track log, Lightroom will determine the location where a photo was captured by comparing the time of capture for each photo and the location you were at that time based on the track log. That, in turn, means that you will see GPS coordinates in the metadata for the updated images, and that the images will be represented by push-pin icons on the map within the Map module.

**Streamlined and Flexible**

While there are a variety of details involved in recording, managing, and employing a track log to add location information to your photos, the actual workflow is quite simple once you’re familiar with that workflow.
One of the advantages of recording a track log is that it generally enables you to track your location over a relatively long duration, without the additional battery drain associated with having a GPS receiver built into your camera. In other words, even if you have a camera that includes a GPS receiver, at times you may prefer to make use of a track log for purposes of easily adding location information to photos you capture while exploring around a location you are visiting.
It always seems that when using a lens with a long focal length, a little “extra” reach would be helpful. And, of course, if you’ve bought a long lens, you already know that the cost can be high, and that buying an even longer lens can be even more expensive. In many cases you may find that adding magnification to an existing lens by using a teleconverter provides an ideal solution.
Gaining Reach

A teleconverter (sometimes referred to as a tele-extender) can be thought of as a lens accessory that provides additional magnification, increasing the effective focal length of a lens. Most teleconverters are available with either 1.4X or 2X magnification. That means the effective focal length can be increased to 140% or 200% of the actual focal length of the lens.

Of course, the specific result depends on the lens you’re using with the teleconverter. Let’s assume a 300mm prime lens. Adding a 1.4X teleconverter provides an effective focal length of 420mm, while a 2X teleconverter provides an effective focal length of 600mm.

As you can probably already appreciate, a 2X teleconverter is much less expensive than a
600mm lens. And packing a 300mm lens and a 2X teleconverter will provide a combination that is much less heavy compared to adding a 600mm lens to your camera bag.

An added benefit of working with a teleconverter is that the lens will still focus to the same near distance. That means you will generally be able to focus more closely with a 300mm lens combined with a 2X teleconverter than you could with a similar 600mm lens.

To be sure, there are a variety of benefits you can gain through the use of a teleconverter.

**Choosing a Teleconverter**

In some respects choosing a teleconverter is relatively straightforward. However, there are some factors you’ll want to keep in mind before deciding on a specific teleconverter.

The most important consideration in my mind is compatibility. Not every teleconverter will work with every lens. Obviously there is the issue of lens mount, such as not trying to use a Canon teleconverter with a Nikon lens.

However, there can also be more significant compatibility issues that limit your options when it comes to pairing a teleconverter with a given lens. The bottom line is that you’ll want to make sure you understand which lenses will—and will not—work with the teleconverter you’re thinking about purchasing.

Related to the overall compatibility issue is the matter of autofocus. Some teleconverters may work with a given camera and lens combination, but might not support autofocus at all with that combination. Again, be sure that the specific
teleconverter you plan to use will support the lenses you’ll use as well as the features—such as autofocus—that you want to employ.

In most cases the safest approach is to opt for a teleconverter from the same manufacturer as the lenses you plan to use with the teleconverter, and to confirm compatibility with the specific lenses you intend to use with that teleconverter.

Beyond compatibility you’ll need to choose a teleconverter based on magnification. As noted above, most teleconverters are available with a 1.4X or a 2X magnification. You may be tempted to simply opt for the higher magnification, but you’ll need to consider the side effects related to the use of teleconverters as part of this decision. And, of course, you may simply want to purchase both a 1.4X and a 2X teleconverter to provide you with greater flexibility without adding significantly to the overall size and weight of the equipment you travel with.

Finally, keep in mind that in many cases you’ll find that manufacturers have released updated versions of their teleconverters. These may sometimes simply represent improvements over the earlier version of a teleconverter, such as greater sharpness and resolution. In some cases, however, the teleconverter version may impact compatibility with specific lenses as well.

**Side Effects**

Regardless of which specific teleconverter you choose, it is very important to understand some of the adverse side effects involved with the use of teleconverters. Many of these side effects relate to the addition of lens elements to the overall assembly being used to capture images.
Perhaps the most fundamental side effect of a teleconverter is a loss of light. By going between the lens and the camera, and adding lens elements in the process, less light will be transmitted by your lens to the camera. With a 1.4X teleconverter you will lose one stop of light, and with a 2X teleconverter you will lose two stops of light.

At a bare minimum this loss of light will impact the overall exposure settings you need to use. In some cases, for example, the addition of a teleconverter may mean you need to raise the ISO setting in order to achieve an acceptably fast shutter speed.

Related to the loss of light is a loss of autofocus performance. That might mean autofocus that is slower than you would achieve without a teleconverter, or a complete loss of autofocus altogether for a given camera and lens combination when using a teleconverter.

*The loss of light caused by a teleconverter can have an impact on autofocus performance, which is important to take into account when choosing your gear and putting it to use in the field.*
The results will vary based on the specific equipment you’re using. Let’s assume, for example, a camera that can only achieve autofocus up to a minimum aperture size of f/8. If you are using a lens with a maximum aperture size of f/5.6, you can obviously achieve autofocus with that lens and camera body combination. If you add a 2X teleconverter to that combination, the maximum effective aperture size is now f/11, which means the camera can no longer focus automatically.

In addition to the loss of autofocus, you can expect a degree of image quality loss from the use of a teleconverter. As a general rule, all other things being equal, an increased number of lens elements has an adverse impact on image quality. By definition, adding a teleconverter results in more lens elements. As a result, overall lens

When using a teleconverter to achieve additional “reach” for a lens, it is important to keep in mind that fine detail in the scene may not be rendered as sharp as would be the case without the teleconverter.
resolution and image quality can be reduced, sometimes somewhat significantly.

Another potential side effect from the use of a teleconverter is the potential to magnify camera movement, increasing the risk of blur. Just as it is recommended to use a faster shutter speed when using a lens with a longer focal length, so too should you employ a faster shutter speed when making use of a teleconverter while shooting hand-held.

In other words, if you follow the rule of thumb that the reciprocal of the shutter speed should be at least the same as the lens focal length, in the context of using a teleconverter that shutter speed should be based on the effective focal length.

For example, you should generally use a shutter speed of at least 1/500th of a second when using a 500mm lens hand-held. If you have added a 2X teleconverter to the lens then you should use a shutter speed of at least 1/1,000th of a second.

**Why Not Just Crop?**

I often hear photographers talking about how they prefer to simply crop the final image rather than employ a teleconverter. In some cases that might be possible, but in other situations it may result in less than ideal results with your images.

I think what many photographers don’t realize is the extent to which they are cropping their images when they have avoided the use of a teleconverter. The severe crop they apply to the image might produce the effect of a theoretical 5X teleconverter. In other words, they are sacrificing considerable resolution from the original capture in order to achieve a given crop.
In many cases the results would have been improved if they had employed a teleconverter so that the same effective crop would result in a larger number of pixels in the final image.

While the loss of sharpness introduced by a teleconverter can certainly be problematic, it is important to keep in mind that significantly cropping a photo and then enlarging the resulting image to achieve the desired final print size can have an even more problematic impact on image quality.

If only a small crop is necessary to achieve the desired framing for an image, then the use of a teleconverter may not have been particularly helpful. In fact, in that case it is altogether possible that the use of a teleconverter would have resulted in too much magnification for the intended framing of your subject. However,
in my experience the use of a teleconverter is preferable to severe cropping of an image when it comes to overall image quality, except in cases where the final image will be enlarged to a very small degree.

The overall concept of a teleconverter is quite simple. All you need to do is attach the lens to your teleconverter and then attach the full assembly to your camera, and you have additional reach with that lens. But there are some additional details that are important to understand about a teleconverter to help ensure you’re able to achieve the maximum benefit with minimal frustration and side effects.
While it may be a bit cliché, I do find that every now and then a neon text effect works well for a given image or composition. Perhaps more importantly, by understanding how you can add a neon text effect to an image in Photoshop, you’ll gain a better understanding of how layer effects work, which can be helpful in a variety of situations. Presented here is a technique for applying a neon effect to text in Photoshop.
Find a Backdrop

In some cases the idea of adding neon text to an image may be a response to the actual content of the photo. For example, perhaps you have a scene that features a large brick wall, and you want to add some neon text to that wall. In other cases you may need to seek out an image that will work for a neon text treatment. In general a relatively open area such as a wall, ideally with a relatively dark overall tonality, works best for this effect. You may even want to apply an adjustment to the image in order to darken it up a bit more to emphasize the glow of your neon text.

When choosing a neon text effect you'll want to select an appropriate backdrop, and possibly darken the image to provide a better fit for the final effect.
Add Your Text

Once you’ve selected—and perhaps adjusted—an image that will work for your neon text effect, you can add a text layer to that image. Start by choosing the Type tool from the toolbox. On the Options bar, select a font that will work well for a neon sign type of look. That generally means a relatively simple font, ideally with rounded corners. The font should generally be of a somewhat medium weight, so it isn’t too bold but also isn’t too thin. Click in the image, type your text, and then click the “Commit” button (the checkmark icon) on the Options bar to apply the changes.

When you add text that you intend to use for a neon effect, you’ll generally want to select a relatively clean and simple font, ideally with rounded corners.
Set Font Attributes

Once you’ve typed your basic text, you can adjust the attributes if you haven’t done so already. In general I find it is much easier to adjust the font size after I’ve actually typed the text. You may also want to adjust the color of the font at this point.

So, first double-click on the thumbnail for the text layer on the Layers panel, which will select all of the text on that layer and activate the Type tool in the process. Then adjust the font size and color using the controls on the Options bar. In general, while it may seem obvious, it is best to use a somewhat “neon” color with a high value for saturation. When you are finished adjusting the font attributes, click the “Commit” button (the checkmark icon) on the Options bar to apply the changes.

After adding the text to your image, you can adjust the overall font attributes such as size and color.
Create a Mask

One of the challenges of a good neon text font treatment is that there are only a handful of fonts that actually mimic the appearance of neon tubes. As a result, you will often want to add a mask to block an interior portion of the text.

Start by holding the Ctrl key on Windows or the Command key on Macintosh while clicking on the thumbnail for the text layer on the Layers panel. This will create a selection for the actual text. Then choose Select > Modify > Contract from the menu. For typical scenarios a value of about 10 pixels should work well for the Contract command. Click OK to apply the change. Then choose Select > Inverse from the menu to invert the selection. Finally, click the Add Layer Mask button (the circle-inside-of-a-rectangle icon) at the bottom of the Layers panel to add a layer mask based on the selection.

Adding a layer mask that hides the interior portion of the text will help create a more realistic neon tube effect.
Apply an Outer Glow

To add a “glow of light” effect for the neon text, you’ll want to add an Outer Glow layer effect. Start by clicking the Layer Effects button (the “fx” icon) at the bottom of the Layers panel, choosing the “Outer Glow” option from the popup menu.

In the Layer Style dialog that appears, set the color to a lighter version of the color you used for the neon text, and adjust the settings to create a glow that suits your text. I generally use a relatively high setting for the Size and Opacity controls, and change the blend mode to Linear Light. You can also adjust the other settings to suit your particular preferences for the glow effect. Click OK to apply the changes.

An Outer Glow layer effect is perhaps the most important element to creating a more realistic neon text effect.
Add an Inner Glow

To add a degree of realism and depth to the neon effect, you can darken the outer edges of the text. For this I recommend an Inner Glow effect. Once again click on the Layer Effects button and choose Inner Glow from the popup. In the Layer Style dialog set the Blend Mode to Multiply, and select a color that is a little darker than the color you used for the text. A relatively low value for the Size slider generally works best, but you can adjust the overall controls to suit your preference for a slightly darkened outer edge for the text. You can click the OK button to apply the changes to the effect settings.

An Outer Glow effect that darkens the edges of the neon text will help add realism to the effect.
Bevel and Emboss

For even greater depth and a bit of a three-dimensional effect, I like to add a Bevel and Emboss effect as well. You can add this effect by clicking the Layer Effects button at the bottom of the Layers panel and choosing “Bevel & Emboss” from the popup menu. I generally prefer the “Inner Bevel” option from the Style popup, adjusting the overall settings for the desired depth of the effect.

In most cases I prefer a relatively low value for the Size setting. Note that you can adjust the Angle value to set the direction from which the virtual light is shining, and therefore which side of your text the highlights and shadows will be added. Once you’ve fine-tuned the effect to your liking, you can click the OK button to apply the changes.

The Bevel and Emboss effect will help add depth to your text.
Refine as Needed

At this point you will have created a neon effect for your text. Of course, you may want to refine some of the settings for that text. If you want to adjust the actual font, unfortunately you’ll either need to discard and later re-create the mask for the text, or you’ll need to create a completely new text layer. Otherwise the font and layer mask will no longer match each other.

If you want to change the font size, you’ll need to use the Free Transform command so the layer mask will be resized along with the text. To do so, click on the thumbnail for the text layer to make sure that layer is active. Then choose Edit > Free Transform from the menu. Hold the Shift key while dragging any corner of the bounding box so the text and layer mask will be resized in sync with each other without altering the aspect ratio. You can then click the “Commit” button (the checkmark icon) on the Options bar to apply the change and finalize your neon effect.

Once you have added the various effects to your text to create a neon effect, you can fine-tune the settings for all aspects of your text to create the final effect.
Diffusion for Healing

A Simple Setting that can Improve Blending for Image Cleanup

Tim Grey

One of the lesser-known settings for the “healing” tools for image cleanup in Photoshop is the Diffusion setting. Part of the reasons this setting is probably not very well known is that it is a relatively new feature, having been introduced with the Photoshop CC 2015 version. In addition, this setting is somewhat “hidden” on the Options bar, and doesn’t necessarily create an obvious effect with casual use. In many cases, however, this setting can be tremendously helpful.
Selecting a Tool

The Diffusion setting relates to the degree of blending to be applied when performing image cleanup work, and so the first thing to understand is that the Diffusion setting is used with image cleanup tools in Photoshop.

The Diffusion setting is only available for tools that actually blend source pixels into a destination area of an image in order to remove blemishes or other distractions. In other words, this setting is not available for the Clone Stamp tool.

In fact, upon casual examination you might assume that the Diffusion setting is only available for the Healing Brush tool, since with the default settings that is the only tool that will include a Diffusion control on the Options bar.

However, the Diffusion setting is also available for the Spot Healing Brush tool as well as the Patch tool. To reveal the Diffusion setting for the Spot Healing Brush tool, you need to choose Proximity Match from the trio of options available for the Type setting. For the Patch tool you need to choose the Normal option from the Patch popup on the Options bar in order to find the Diffusion setting.

Which tool makes the most sense for you depends on the specific cleanup task you’re dealing with and your preferred workflow approach. For example, the Patch tool is best if you prefer to use a selection as the basis of your image cleanup. The Spot Healing Brush tool or Healing Brush tool are best if you want to paint your cleanup into the image, with...
the former selecting a source of pixels automatically and the latter enabling you to choose a specific source of pixels for your cleanup work.

I certainly wouldn’t suggest choosing a specific cleanup tool or a specific mode for that cleanup tool just to be able to make use of the Diffusion setting. Instead, I recommend evaluating the value for the Diffusion setting only when it makes the most sense to use a tool that includes that setting. As a general rule this means that you should consider the best setting for Diffusion when only after you have found a situation where the Content-Aware technology in Photoshop isn’t providing a satisfactory result.

**Understanding Diffusion**

For the tools that include a Diffusion setting, there is a degree of blending being applied to the source pixels for your image cleanup that is intended to help ensure those pixels blend as seamlessly as possible into the destination area. The Diffusion setting, by extension, determines the degree to which the edges of the cleanup area are blended into surrounding areas of the photo.

The first thing to understand about the Diffusion setting is that it won’t impact the overall cleanup behavior of the image cleanup tools in Photoshop. In other words, you’ll still be getting the core benefit of the cleanup tool, and the overall effect won’t change. All that is impacted is the degree of blending along the edges of the area you are cleaning up.

In a very simple way, you can think of the Diffusion setting as providing you with a gradation along the edges of all of your cleanup work. Of course what is happening “behind the scenes” is more complicated...
than that, but I think this is a reasonable way of thinking about this setting.

With the Diffusion setting at a low value, there will be very minimal blending along the edges of your cleanup areas. With the Diffusion setting at a high value there will be more significant blending along those edges.

**Choosing a Setting**

One of the challenges of establishing an optimal value for the Diffusion setting is that you can't see a preview of the final effect until after you’ve actually performed some cleanup work. However, you can get a very good sense of how the setting impacts your image cleanup results by performing some simple tests.

As a general rule, you’ll want to use a relatively low value for the Diffusion setting when it is critical to retain detail and texture in the areas of the image.
With a higher value for Diffusion less detail will be retained in areas you’re applying cleanup to the image, due to the increased blending applied in those areas of the image.

where you’re performing your cleanup work. You’ll want to use a relatively high setting when you are working in a smoother area where you want to ensure the maximum amount of blending for more seamless results.

By testing different Diffusion settings in various areas of a photo, you’ll gain a better sense of what setting will make sense under specific circumstances. I therefore highly recommend opening up a test image and performing some sample cleanup work in various areas, using different values for the Diffusion setting along the way. In particular, I recommend switching between the minimum value of 1 and the maximum value of 7 while working with a cleanup tool in highly textured as well as very smooth areas of an image.

When it doubt, you will generally get good overall results with a Diffusion value of around 4 or 5. However, by being familiar with the impact
of the Diffusion setting and performing some tests to get a better sense of this option, you’ll be able to anticipate when a higher or lower setting will be helpful.

I think it is also helpful to keep in mind that you can always perform a quick test while performing image cleanup on a photo. If the result isn’t optimal, you can undo your last cleanup step, adjust the setting for Diffusion, and repeat the cleanup work.

The key is to first be aware that the Diffusion setting even exists, to understand the basic concept involved with this setting, and to remember that you can adjust the value as needed to help improve your overall image cleanup results when working with certain tools in Photoshop.

A moderate setting for Diffusion will balance blending with the retention of detail within areas of the image where you are performing cleanup work.
It seems to me that there is an ebb and flow in the popularity of time-lapse videos. Just as they seem to become popular once again, suddenly the tide turns and fewer photographers are creating time-lapse videos. If you haven’t created a time-lapse video in a while—or ever—you may want to revisit the technique, using the tips provided here to help you streamline your capture process.
Use an Empty Card

I don’t even remember the last time I saw a photographer who didn’t have at least one—and generally a few—spare media cards. And yet, it seems to be getting increasingly rare to see a photographer actually switch cards because the first card got full. Even with cameras providing incredibly high resolution, media card capacity seems to have kept up so that many photographers can get through a typical photography outing without changing cards.

As a result, it is quite likely that a photographer could easily capture a sequence of time-lapse images on a card they have been using for “normal” captures, without the risk of having the card get full.

However, I still recommend using a fresh media card when capturing a time-lapse sequence. To begin with, doing so will help ensure that you have adequate storage space for a large number of captures, and time-lapse captures can certainly add up quickly.

In addition, using a separate card for the captures that will be part of a time-lapse sequence can help streamline your organizational workflow. At a very basic level, using a separate card will ensure that you will download the time-lapse captures separate from the other photos you have captured. That, in turn, will provide the opportunity to further organize the time-lapse captures, such as by downloading them into a subfolder that is separate from your other photos.

Rename the Captures

In most cases I recommend resetting the file numbering setting in your camera before
initiating a time-lapse capture sequence, in order to help keep those captures organized. This will help ensure, for example, that you are able to capture a large number of photos as part of a time-lapse sequence without having the file naming “roll over” to a sequence number of “0001”.

For example, if you start a time-lapse capture sequence when the camera is currently at a filename sequence number of 9900, and you capture two-hundred images as part of the time-lapse, midway through the captures the file numbering will switch from “9999” to “0001”. This can be confusing, especially if you tend to sort your photos alphabetically by filename.

Of course, resetting the file numbering can also create a degree of confusion with non-time-lapse photos that were captured before and after a time-lapse sequence.

Renaming the captures you’ll assemble into a time-lapse video can be helpful. For example, the images can be renamed upon import into Lightroom if you didn’t reset the file naming on your camera at the time of capture.
To me the ideal solution is to rename your photos after they have been captured, as part of the process of downloading the photos. As noted above, I recommend using a “fresh” media card when capturing time-lapse image sequences. This makes it relatively easy to apply custom renaming at the time that you are downloading your photos.

Quite frankly, if you will be capturing time-lapse sequences on a somewhat regular basis, I recommend renaming not only your time-lapse captures, but also your “normal” captures. After all, with time-lapse photography you will be capturing a relatively large number of photos over time.

Many cameras are limited to a four-digit sequence number, which only contributes to the challenge of time-lapse photography. Even with a modest number of time-lapse captures, you may find you are rolling over to a starting number of “0001” for the filenames for your photos on a somewhat regular basis. That, in turn, can lead to a degree of confusion when it comes to browsing and searching for images.

By renaming all photos as they are added to your library, you’ll help avoid this confusion. And by resetting the numbering in your camera before initiating a time-lapse capture, you’ll also help streamline the initial process of reviewing your sequence of captures for a time-lapse video.

**Capture in JPEG**

While there are a variety of potential benefits to using a RAW capture format in your photography, for time-lapse sequences this is generally not necessary. If you are going to use JPEG capture it is obviously more important to ensure that the overall exposure and white balance settings are appropriate
for the scene you’re photographing. Once you have established those settings, there isn’t a significant benefit to using RAW capture.

With most relatively new cameras it is possible to capture a large number of photos in a RAW format without filling up the buffer on your camera or exceeding the capacity of your media card. Still, there is not a significant benefit to RAW capture in the context of a time-lapse video. As a result, I recommend using the JPEG capture format for images that will be part of a time-lapse sequence.

By capturing in the JPEG format you’ll help ensure you are able to capture the maximum number of photos as part of your time-lapse. You’ll also help reduce the overall storage requirements for those captures, helping to streamline your workflow without a significant impact on the overall quality of your final time-lapse video.
Use Full Resolution

I often hear the suggestion that for time-lapse videos you can use a reduced resolution setting in your camera. Many videos are still produced as 720p or 1080p high definition (HD) videos. Those video resolutions only require image dimensions of 1280x720 pixels for 720p or 1920x1080 pixels for 1080p video.

Of course, these days 4K video is increasingly popular, which calls for pixel dimensions of around 4096x2160 pixels. Note that there are a variety of different specific resolution dimensions that fall under the “4K” heading. Ultimately, 4K resolution represents around 9 megapixels of image data.

Considering that most digital cameras provide resolution well above 9 megapixels, you may assume that using a relatively low resolution for your initial time-lapse captures makes perfect sense. However, keep in mind that using a higher resolution for the captures than you actually need for the final time-lapse video will provide greater flexibility for the final video.

For example, you can zoom in and pan around the scene using video editing tools after you have assembled the initial time-lapse video. This can provide a higher degree of production value in the final result. Put simply, capturing at full resolution will provide greater flexibility in post-processing, and won’t consume a significant amount of additional storage space when using the JPEG format for your time-lapse captures.

Consider Manual Exposure

In general I prefer—and highly recommend—using manual exposure mode for time-lapse captures. That said, manual exposure isn’t always the best solution.
The reason manual exposure is generally best for time-lapse captures is that a consistent exposure setting will help ensure there is no flickering in the final video. If you are using an automatic exposure mode, changes in the contents of the scene in front of the lens can cause changes in the calculated exposure value.

In other words, the camera may compensate for changes in the brightness level in the scene, resulting in unwanted changes in tonality in your final video.

For example, let’s assume you are creating a time-lapse of clouds passing across a landscape. If a large cloud casts a shadow in the foreground near the camera, that may cause the camera to compensate by brightening up the overall scene. That, in turn, will cause the rest of the image to...
brighten and then darken as the shadow passes into and then out of the scene. That variability can obviously be problematic.

Of course, in some cases you may want to compromise and use an automatic exposure mode. If you’ll be capturing a time-lapse that transitions from afternoon into evening and night, you may want to allow the camera to compensate for the change. But in general it is best to find good overall exposure settings and lock those in using the manual exposure mode.

**Use a Custom White Balance**

Just as an automatic exposure mode can cause problematic variability from frame to frame in your time-lapse video, so too can an automatic white balance setting. I highly recommend locking in the overall color appearance of your time-lapse captures by making use of a white balance preset.

By using a white balance preset (or a manual color temperature setting) you’ll ensure consistency in terms of color rendering for all captures in your time-lapse video. That will prevent unwanted
variations in color from one frame to the next, which will either create distracting color changes in your time-lapse video or require significant work in post-processing to ensure consistent color.

**Slow Down the Shutter**

When you are determining your overall exposure settings for the time-lapse captures, you might consider trying to slow down the shutter speed to around a 1/30th of a second exposure time. The ideal shutter speed will depend upon the specific scene you are photographing, and the degree of motion that is present.

The basic idea here is that using a relatively slow shutter speed will create a degree of motion blur that helps create a more realistic and pleasing effect in the final video. If you use a fast shutter speed that freezes all motion in the scene, the resulting video will have something of a “stuttering” look to it.

In general I aim for a 1/30th of a second shutter speed for most time-lapse captures. However, in some cases you may want to use an even longer exposure time. For example, let’s assume you are creating a time-lapse of a city scene at night with cars driving through your scene. If you are capturing photos every five seconds, you could easily use a one-second exposure time to produce dramatic streaks of light in each frame of your time-lapse.

**Ditch the Tripod (Sometimes)**

To be sure, it is exceedingly rare for me to capture a time-lapse video without using a tripod. I almost always want to use a tripod in order to ensure a stable platform where the camera isn't moving, and where the only movement in the final time-lapse video is the movement of subjects within my scene.
However, you can also create very interesting results by introducing movement to your camera while capturing your time-lapse frames.

There are, for example, some very sophisticated rigs that enable you to have your camera pan across a scene while capturing your time-lapse frames, adding a dynamic element to the time-lapse video that goes beyond a typical static time-lapse framing.

It is even possible to hand-hold the camera and move it through a scene. You might also find a way to attach your camera to a vehicle so you can move the camera with more stability—or over a greater distance—while capturing your time-lapse images.

The point is to think about different ways you can capture a sequence of images for a time-lapse video without simply putting the camera on a static tripod. You might even consider moving the tripod...
in between every capture of a time-lapse sequence, in order to add an element of motion without sacrificing stability for the camera.

**Go Beyond the Cliché**

The overall concept of a time-lapse video is very simple. All you need to do is capture a large number of photos with a set interval, and then assemble those photos into a video. Of course, I’ve seen countless time-lapse videos that lack interest and include distracting elements. Too often a time-lapse video presents a not-too-interesting scene captured from a fixed location.

By going beyond a very simple setup for a time-lapse, being careful to use best practices when configuring the capture settings, and thinking about how you can make your time-lapse video unique and interesting, you’ll be able to create a final video that will grab the interest of your viewers.
Pixology magazine is published electronically on a monthly basis. For more information, visit: www.pixologymag.com

To contact the publisher:
Tim Grey • 243 5th Ave #131 • New York, NY 10016
www.timgrey.com
tim@timgrey.com

Follow Tim Grey at:
Facebook Twitter Instagram YouTube LinkedIn Google+

Every attempt has been made throughout these articles to distinguish proprietary trademarks from descriptive terms by following the capitalization style used by the manufacturer and marking those marks as either a trademark or registered trademark. All trademarks and registered trademarks included in this book are the property of their respective owners. The publisher has made best efforts to prepare this magazine, but makes no representation or warranties of any kind with regard to the completeness or accuracy of the contents herein and accept no liability of any kind including but not limited to performance, merchantability, fitness for any particular purpose, or any losses or damages of any kind caused or alleged to be caused directly or indirectly from this book.
Harbor seals on a small iceberg in the Inside Passage of Alaska. Captured at a lens focal length of 380mm with an aperture of f/8 and a shutter speed of 1/1000th seconds at ISO 400.